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1 Introduction 

In a traditional sales process, the steps from an enquiry to an order are often very time-consuming as 

people use different software solutions. However, Configura

 offers a complete solution for designing 

and selling products. 

1.1 What is Configura? 

Configura is the leading graphical product configurator on the market. Our software automates the 
sales process for the following industries: 

- Kitchen & Bath 

- Commercial Furniture 

- Material Handling 

- Industrial Machinery 

  
In the Configura software you work with simple graphical symbols, which allow you to focus on the 
space planning and the design of your products. The software is rule-based; it knows the capabilities 
and limitations for each individual product and does not allow you to make mistakes. When you have 
finished with your layout, all required information (product specifications, quotes, 3D renderings and 
order data) has been generated automatically. 
 

 
 Client Sales Order 
 

Configura simplifies the process from the customer enquiry to an order. 

 

 
Configura allows you to be at the customer's site, offering the optimal business solution right there on 
the spot. 
 
For more information, please ask for one of our brochures or visit our website at www.configura.com  

1.2 Purpose of this Material 

This guide is designed to complement our teacher-controlled training courses and is used throughout 
the Basic Course. Here you will find the majority of the exercises that we work with during the two 
days. This is a reference material which you can go back to, to repeat the different items after the 
course. 

 
The Basic Course teaches essential skills and concepts that can be applied to any customization of 
Configura. After the course you will have received a great deal of inspiration, tips and ideas! 
 
For additional orders of this material, please contact training@configura.com 

 

http://www.configura.com/
mailto:training@configura.com
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2 Getting Familiar with Configura 

Together with your product knowledge, learning the basics of the core application (hereby referred to 
as “Configura Core”) will enable you to quickly get started with your new sales tool. 

2.1 Work Area 

The Configura work area has a clear and simple design. Starting at the top and then working our way 
down, it is made up of a title bar with the name and the version number of the customized version, the 
menu bar and the toolbar. On the left, below the toolbar, are the component tabs and on the right the 
drawing area. 

1.  Title bar  

2.  Menu bar 

3.  Toolbar  

4.  Component tabs (vertical and horizontal)  

5.  Status bar (with price and scale) 

6.  Drawing area (unlimited size - click and drag it to any direction) 
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2.2 Adjusting Default User Settings 

Selecting the language, in which you would like to run Configura, is one of the initial default settings 
that you need to do after you have installed the program for the first time. In order to do so, go to the 
File menu and select Control Panel to display a dialog with four tabs – General, User Interface, 
Auto 3D and JPG. All settings made in this dialog will be saved and you do not need to select them 
again when installing new versions of Configura.  
 

 
Configura’s Control Panel. 

 

The General tab in the Control Panel contains three main fields: Regional Settings (1), Drawing 

File Settings (2) and File Locations (3). On this tab, you will find the settings which are most 

important at an initial stage.  
 
In the Regional Settings field (1) you select the language in which you would like to run the program 
as well as the desired dimension unit. 
  
In the Drawing File Settings field (2), we recommend you to activate the Auto save at interval 
function. This way, your work is being saved at regular intervals. In the text field to the right, you can 
enter how often your work should be saved (every 1 to 60 minutes). Auto save only saves the 10 most 
recent versions of your drawing. To find the drawings that Configura has saved automatically, go to 
the File menu and choose Open Autosaved Drawing. In the text field next to Number of recent 
drawings you decide how many of your recently opened files you want to be displayed when clicking 
on Recent Drawings in the File menu. The minimum number is 1 and the maximum is 12. 
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In the File Locations field (3) you can define paths to many of the different types of files, which are 
opened and saved during your work in the program.  
 
In order to define new paths to one of the alternatives above, proceed as follows: 

1. Select the desired alternative by clicking on it, for example the Favorites option, to determine 
where all your favorites you create should be saved. 

2. Click the Browse button and define the desired path. 

3. In the Use column, make sure that the box is checked.  
 
Below the two main fields, you will see the Calculate price option. Checking this box will allow the 
price of the component(s) that you place in the drawing area to be displayed. The price information is 
shown in the status bar in the bottom left-hand corner of the Configura window. 

 
Note:  

 Once you have chosen the language and dimension unit, the Control Panel closes, when you 
click on OK or Apply. This is so that Configura can be updated according to the changes you 
have made. To select additional settings, you must open the dialog box from the File menu, and 
choose Control Panel again. 

 The content of the Control Panel dialog might vary, depending on the number of functions that 
have been included in the different customizations of Configura. 

 The menu item Open Autosaved Drawings does not appear in the File menu until you activate 
the Auto save at interval option in the Control Panel.  
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3 Working with Components 

In the program, all objects that can be picked from one of the component tabs in the left-hand part of 
the program window and then positioned in the drawing area are referred to as "components". If you 
hover the mouse pointer over a component, a short help text is displayed with the name of the 
component along with the information about it. 

3.1 Applying Pre-Settings for Components 

Before placing the desired component on to the drawing area, you have to start from the top of the 
component tab and work your way down in order to apply the desired pre-settings. 

3.2 Picking and Placing 

You position most components in the drawing area by choosing a component on the tab by clicking 
on it, moving the mouse pointer (Note: You do not need to keep the mouse button pressed down!) to 
the drawing area and by clicking the component in the desired position. In Configura, this process is 
called “pick and place”.  
 
After you have positioned a component in the drawing area, you can click an almost unlimited number 
of times to add new occurrences of the same component in the drawing area. One click for each 
component is all that is needed. If you do not want to position several components of the same type, 
move the pointer outside the drawing area. The pointer drops the current component.  

3.3 Selecting Components 

To be able to alter a component in the drawing area, it has to be selected first. When a component is 
selected, its yellow snap points are visible. A component is automatically selected when it is placed in 
the drawing area. You can:  

- select a component by clicking it.  

- deselect/clear the selection by clicking somewhere else in the drawing area, another component 
or by placing a new component in the drawing area.  

- select multiple components by pressing and holding the Ctrl key whilst clicking the desired 
components. You can also use the Select Rectangle feature on the toolbar or press and hold 
down the Shift key, whilst pressing the left mouse button and dragging the mouse pointer 
diagonally across the group of components you want to select. 

- select only one in a group by first disconnecting the component. See Disconnecting Components 
for further details. 

3.4 Snapping Components  

Most components in Configura have yellow snap points (see figure further down). These snap points 
allow components to automatically attach to each other (snap into place). Snapping works in various 
ways. Some components snap together at their edges. Others snap together leaving space in 
between, and others along a line. The snapping behavior is rule-based. 

- The yellow square identifies that the component is selected and not snapped to another 
component at that connection point.  

- The yellow triangle identifies that the component is selected and snapped to another component 
at that connection point. 
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3.4.1 Disconnecting Components 

When two or more components are attached (snapped together) and selected, the snap points are 
visible. Snapped components automatically form a group. This means that if one component is 
moved, the other components in the group will move automatically as well. Consequently, it also 
means that if one component is removed, the other components in the group will also be removed.  
 
To move or remove only one component in the group, the component must be disconnected. Follow 
these steps: 

1. Click on the component to select it.  

2. Click on the yellow triangular snap point to disconnect the component (see figure below). 

 

 

 
 

 

The yellow triangle indicates that the chair is snapped to the desk and that the two components are grouped. Click on the 
triangle to disconnect the chair from the desk. 
 

3.4.2 Deactivating Snapping   

There may be times when you want to temporarily turn off automatic snapping. You can deactivate 
automatic snapping by pressing and holding down the Shift key while working with the components. 
 

  

When placing a chair beside a desk, the chair is automatically attached to the desk. If you want to place the chair close to the 
desk but not in the position that Configura suggests, press Shift on the keyboard while moving the chair. It is now possible to 
place the chair exactly where you want it.  
 

Note: You can also deactivate snap points by clicking it. The snap point turns gray which means that 
the snap point is deactivated.  

3.4.3 Rotating Components 

You can either place the component first and then rotate it, or rotate it while you place it. The two 
different ways are described below:  

Follow these steps to rotate a component already placed in the drawing area: 

1. Select the component by clicking it.  

2. Click and hold the yellow square point and drag it in the desired direction. 

3. While rotating the component, the component's angles are shown. Continue rotating until you 
have the desired angle.  

4. Release the mouse button when the component has been rotated to the desired position. 
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Follow these steps to rotate a component while placing it in the drawing area:  

1. Pick a component and move it to the drawing area. 

2. Hold the mouse button down and move the component along the depth axis. Note that if you 
move it in the wrong direction, its width stretches instead. 

3. While rotating the component, the component's angles are shown. Continue rotating until you 
have the desired angle.  

4. Release the mouse button when the component has been rotated to the desired position. 

3.5 Changing Component Properties after Placement 

The majority of the components in Configura have a dialog where settings can be made after they 
have been placed in the drawing area. You access the Settings dialog by right-clicking on the 
component in the drawing area and choosing Settings from the pop-up menu.  
 
For some components in Configura, double-clicking on them evokes a special feature or behavior. 
This could be a door of a cabinet component opening, a newspaper component going from open to 
closed etc. If a component does not contain this special behavior, the double-click will simply open its 
Settings dialog.  
 
Most settings dialog boxes for components contain the field Apply to, in which you can choose all the 
components that you want to change. This can be a group of components, components in a selected 
position or all the same type of components in the drawing area. The changes can affect, for example, 
the size, material or color of the components.  
 
Apply to can be accessed simply by right-clicking on the component you want to change and select 
Settings from the pop-up menu which appears, or choose Material/Color, depending on what you 
want to change.  
 
In the bottom left-hand corner of these dialog boxes you will find the following options in the Apply to 
pull-down list:  
 The Selected component option changes the component that you have selected. 
 Group changes a group of components. The components make up a temporary group.   
 Position changes components, which have been enclosed by one of the Positioning 

Components on the Tools tab.  
 The All option changes all similar components in the drawing area. For example, this could be all 

the desks or all the doors in a large drawing. 

 
 
This dialog box is displayed when you right-click on one of the office desks in Configura. Should you wish to change several 
components at the same time, do not forget to select Group, Position, or All under Apply to. 
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3.6 Confirming Settings 

When you have chosen the settings you desire in any of Configura's dialog boxes, you can click on 
OK, Apply or Cancel: 

 OK: When you click on OK, you confirm your selection and the dialog box is closed. If you are 
sure that you have chosen the right settings, click on OK. 

 Apply: If you are not sure that you have chosen the right settings, test them first by clicking on 
Apply: When you click on Apply, the settings you have chosen are displayed, but the dialog box 
is not closed. When you are happy with your choice, click on OK. 

 Cancel: Cancel deletes the settings you have chosen and closes the dialog box.  

3.7 Removing Components  

To remove a component from the drawing area, use the standard procedure for deletion: select the 
desired component/group and press the Delete key on the keyboard. 

3.8 Stretching and Shrinking Components 

Some components in Configura can be stretched in width, depth and height dimensions. The snap 
points are used to stretch and shrink components. 
 
There are two methods that can be used for stretching components: 
 
Method 1 – Stretch after placement: 

1. Select the component by clicking it.  

2. Click and hold the snap point, and then drag it in the direction you would like to stretch the 
component to.   

3. An input box appears displaying the component's permitted widths. Drag to the desired width.  

4. Release the mouse button. 

 
Method 2 – Stretch during placement: 

1. Pick a component and move it to the drawing area. 

2. Hold down the mouse button and drag it in the direction you would like to stretch it. Note that you 
can only stretch the component's width using this method.  

3. An input box appears with the component's permitted widths. Drag to the desired width.  

4. Release the mouse button. 

3.9 Moving Components 

A component or groups of components can easily be moved in the drawing area: 

1. Select the component or the group. 

2. Click and drag the component/group to the desired location in the drawing area. Release the 
mouse button when done.  

 

You can also move components or groups of components, by selecting the component/group and 
then pressing one of the four arrow keys on your keyboard. When using the arrow keys to move 
components, the snapping feature is turned off. 
 
Note: If you would like to move the component more gradually within the drawing area, hold down the 
Ctrl key and use the arrow keys.  
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3.10 Cut, Copy and Paste 

Cut, Copy and Paste work in Configura just as they work in any Windows based program. 
 

3.11 Using Elevation Views  

An elevation view shows a component at the front in the drawing area and is a complement to the 
plan view. In Configura Core, elevation views are only used for some of the program's components, 
for example, cupboards with different front panels or amount of shelves. In order to be able to alter 
components like these, they have to be visualized in another view than the plan view. In Configura 
Core, those components that have elevations connected to them are found under the main section 
Office/Home on the Storage tab.  

 
A cabinet from the Storage tab is not complete until it has a Base and a Storage Frame (see below).  
 

  

Base                      Storage Frame 

 
 

The Base is the main component that you have to start with. In the drawing area, the base appears 
as the object would look from above in a plan view. When the Storage Frame is added, you have a 
cabinet that can be viewed in 3D.  

 

To position a base and its elevation in the drawing area, follow the instructions below:  

1. Select the Base component and position it in the drawing area. The base has dashed lines and a 
red cross on the component indicates that it is not complete. 

2. Select the Storage frame component and move it onto the drawing area. When it snaps to the 
Base, click to position it. The dashed lines on the base are now solid and the cross disappears. 
Now you have a complete cabinet.  

3. Continue to add the desired set of doors, shelves or drawers, by snapping them onto the frame. 

      

Note: 

 In Configura Core, the word 'elevation' is used. However in some customized versions of our 
program, elevations are also referred to as references, front views, side views etc. 

 You can move an elevation view in the drawing area without affecting the base. 

 The Base can be stretched, rotated and moved in the same way as other components. 

 The height of the Storage Frame can be adjusted, by clicking on the topmost snap point on the 
elevation view and stretching it height wise. However, this has to be done before you add an 
interior (doors, shelves, drawers etc.) to the frame. 

 You cannot remove an elevation view by activating it and pressing Delete. Instead, select the 
Base and delete it. The elevation view will be removed automatically. 
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4 Navigating in Configura 

4.1 Zooming and Panning 

In Configura you can adjust the drawing-area view using the mouse wheel. All you need is a scroll-
wheel mouse. 
 
This will enable you to: 

 Zoom in and out of a drawing in order to view it in different scales. 

 Pan around, i.e. move the drawing area, in different directions while holding a component without 
changing the drawing magnification. 

 
Note: 

 If you are working on a large drawing and you want to shift between magnified close-up views and 
a smaller-scale overview, proceed in one of the following ways:  
a) Scroll the mouse wheel. 
b) Use the Ctrl key and double-click in the drawing area simultaneously. To magnify a detail, 

press and hold down the Ctrl key at the same time as you press and hold the mouse button. 
Then drag the rectangle diagonally across the components you want to zoom in on and 
release the mouse button. To return to your previous zooming position, simply double-click in 
the drawing area. 

 

 If you need to drag the drawing area during an active command, use the program‟s panning 
options. For example, let us assume that you are adding dimensions to a drawing. In order to 
snap the dimension to the correct starting point, you need to zoom in to get a detailed close-up 
view. Now, however, you can no longer see the end point because of this close-up. To be able to 
move the plan view at his stage (without losing your dimension component), press and hold the 
mouse wheel. The “hand” tool now appears which enables you to move the drawing area around 
to view the desired area. 
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5 Using the Drawing Functions 

The following section of this documentation provides information about the different drawing options in 
Configura. 

5.1 Creating a New Drawing 

To create a new drawing in Configura, follow the steps below: 

1. Go to the File menu and select New or click the New Drawing icon on the toolbar. 

2. If you have already positioned some components in the drawing area, a "Do you want to save the 
changes…?” dialog box appears. To save the current drawing, select Save. To close the drawing 
without saving, select Do not save. 

3. A new, blank drawing area appears. 

 

5.2 Saving and Naming a Drawing 

The recommended next step is to name and save your drawing. Follow these steps: 

1. Go to the File menu and select Save As or click the Save icon on the toolbar.  

2. The Save As dialog box opens. Browse to the location where you wish to save your drawing. 

3. Name the drawing in the File name field.  

4. Click the Save button. The file will be saved in the .om file format.  

 
If you have saved and named the drawing from the start, you only need to click Save occasionally 
while you are working and after you have finished. The auto-save feature will also periodically create 
a backup file of your drawing. 
 

5.3 Opening a Drawing 

To locate and open a saved drawing, follow these steps:  

1. Go to the File menu and select Open or click the Open icon on the toolbar.  

2. The Open dialog box opens. Browse to the desired drawing. 

3. Select the .om file that you would like to open and select Open. 

 

5.4 Undoing/Redoing 

Use the Undo option to remove the most recent action. To use undo, click the Undo icon on the 
toolbar or select Undo from the Edit menu. Undo can be clicked several times to remove multiple 
steps. 
 
Use the Redo option to re-apply a previous action. To use redo, click the Redo icon on the toolbar or 
select Redo from the Edit menu. You can click on Redo several times to re-apply multiple steps. 
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5.5 Using Favorites 

Use Save as favorites/Paste Favorites (from the Edit menu) to save and insert a common setup or 
any combination of selected components that you frequently use. While cut, copy and paste allow you 
to re-use selected components, favorites are saved files that can be inserted in drawings and shared 
with others. 
 
Creating a Favorite  

1. Right-click on the selected component or group of components. 

2. Select Save as favorites. 

3. The Save as dialog opens. 

4. Enter a File name. 

5. Click Save. 

 
Inserting a Favorite  

1. Right-click in the drawing area.  

2. Select Paste favorites. 

3. The Open dialog box opens. Select your favorite. 

4. Click Open.  

5. The favorite will appear with the mouse pointer. 

6. Click in the drawing area where the favorite should be inserted. 

7. To continue pasting favorites, click in the drawing area. 

8. To stop inserting favorites, move the mouse pointer outside the drawing area.  
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Exercise 1- Creating a Drawing  

 
Proceed as follows: 

1. Go to File > Control Panel to choose language and dimension unit. Activate the Auto save 
function. 

2. If the drawing area is empty, click on Save as in the File menu to name the file from the start and 
determine where it should be saved. If the drawing area is not empty, click on New drawing and 
then Save as. 

3. Create a simple drawing layout by adding two walls and a couple of components. Try rotating and 
stretching the components and see how they snap. Press the Shift key to see how the snap 
function is deactivated.  

4. When the drawing is ready, go to the File menu and choose Save or simply click on the Save 
button in the toolbar. 

 

5. To open the drawing again, go to the File menu and choose Open. Search for the destination 
where you saved the drawing. 

 
Note:  

To avoid having to build from scratch each time, it is a good idea to create favorites of commonly used 
groups. This will give you quick access to product combinations that you use often. To create a 
favorite, you first have to make a temporary group of components. Press and hold the Ctrl key as you 
click on and, thereby, select each of the components. Place the mouse pointer on one of the selected 
components, right-click and choose Save as favorites. Name the file and save it in a folder on your 
network. It also allows you full flexibility, as any group can be built from these basic components. To 
paste the favorite, right-click in the white drawing area and select Paste favorites. In the folder where 
you saved the file, select it and choose Open. The favorite is placed at the position of the mouse 
pointer. You can paste the component as many times as you want. 
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6 Importing Cad 

Cad (Computer Aided Design) systems are used for creating architectural and construction drawings. 
Configura supports import and export of the two most common Cad file formats - dwg and dxf. All 
import and export options are found on the Import and Export tab (see figure below).  

 

The Import Cad Drawings (dwg/dxf) section contains two features that enable the import of dxg and 
dxf files: 

1. Import Cad Drawing (dwg/dxf)  

Place the red component in the drawing area to 
bring up a dialog to enable the import of dwg 
and dxf drawings and models. 

2. Drawing Data 

Having imported a Cad file, you can select the 
Drawing Data option to open a dialog that 
contains information of the current drawing. 
From here, you can modify layer color, hide 
information in certain layers or turn on/off their 
3D information. 

 

 

 
The picture shows a Cad file that has been imported to Configura’s drawing area. 
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Exercise 2 – Importing a Cad Drawing 

Using the program's Cad feature, Import Cad Drawing (dwg/dxf) (picture 1), you can import 
drawings and models saved in the file formats dwg or dxf. 

  
Proceed as follows: 

1. Select the Import Cad Drawing (dwg/dxf) component (picture 1) from the Import and Export 
tab and position it in the drawing area. The Cad (dwg/dxf) Import Settings dialog box is 
displayed (see picture 2). 

 

 

Picture 1 

 

Picture 2 

2. In the File field, click on the Browse button to find the dwg/dxf file that you want to import.  

3. In the Properties field, select the desired Scale (i.e. the drawing scale which the drawing was 
made in). Click on one of the pre-defined buttons or enter the desired scale in the text field shown 
when selecting the rightmost button. 

4. Select the Model Space Unit, i.e. the geometrical unit that was used for the original drawing.  

5. When you are happy with your settings, click on OK.  

6. When the Cad drawing is imported, all its entities are placed in one single block. This means that 
you have imported one single drawing object to the drawing area, which enables a quick import. 

7. If you use the Select Rectangle to select the whole drawing, you will see a yellow snap point in 
the upper left-hand corner of the drawing. This snap point is a reference to the whole block. 
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Exercise 3 – Working with the Imported Drawing 

In Configura there are several ways of changing the drawing information that has been imported from 
Cad. You can change the color of the different layers and also move, rotate or delete Cad entities 
from the drawing area.  
 
When a Cad drawing is first imported to the drawing area all of its entities are placed in one single 
block. If you select the whole drawing using the Select Rectangle, a yellow snap point representing 
this block will appear in the top left-hand corner of the drawing. All entities have their own individual 
snap point, which is always shown in the top left corner.      

 

 Note: The Cad term "entity" simply means an object (block or smaller parts) in a dwg/dxf drawing. 

 The snap point could be difficult to notice in certain drawings. In order to spot it easier zoom in on 

the drawing after using the Select Rectangle. 

 

 

Before importing a Cad drawing it is important to consider what you intend to do with the drawing. 
These are the following alternatives:  

A. Use the drawing as a background for your future planning in Configura. 

B. Explode and modify the original imported drawing, for example, to move, rotate or remove 
entities. 

C. Crop the Cad drawing. 

D. Convert the Cad drawing into a Configura drawing. 

 

----------------------------------------------------------------------------------------------------------------------------  
A. If you simply want to use the drawing as a background, select the file, choose the desired Scale 

and Model Space Unit and confirm with OK. Then continue as follows:  

1. Click on the button Drawing Data. A dialog box is displayed.  

2. Turn off the layers that you do not require. Go to the column where it says On/Off and click 
on each individual layer that you do not require. This means that you turn off, or hide, that 
information temporarily on the drawing. An easy way of identifying what information a certain 
layer has, is to allow the mouse pointer to hover over the part of the drawing that you are 
interested in. A help text is then displayed, which tells you what information that layer has. 

3. Click Apply or OK. 

4. Plan the space with your products in Configura and complete the layout proposal. 
 

----------------------------------------------------------------------------------------------------------------------------  



17 

 

B. If you wish to modify the imported drawing for various reasons, proceed as follows after you have 
selected the file, chosen the desired Scale and Model Space Unit and confirmed with OK.  

1. Turn off the layers that you do not require. 

2. Explode the drawing into smaller entities by right-clicking on the yellow snap point in the top 
left-hand corner of the drawing or on an optional block entity within the drawing (for example a 
text block which is easy to select). The Explode block option appears as an alternative in the 
menu.    

3. Select Explode block. The drawing now retains its original block division. 

4. It is now possible to select an individual entity on the drawing by clicking on it or by using the 
Select Rectangle. When the entity's yellow snap point is visible, you can move, rotate or 
remove the entity. 

5. It is also possible to split a block entity into its constituent parts. This is done by right-clicking 
on the entity and then choosing Explode block. 

Note:  

 The fact that all entities initially are grouped in one single block results in a faster importing 
process. When you have exploded the drawing for the first time, you retain the original 
dwg/dxf block division.   

 When exploding a larger drawing a great deal of memory is used. However, working with the 
drawing (such as zooming in/out in the drawing area) will be much faster. 

 
 
 
 --------------------------------------------------------------------------------------------------------------------------- 
C. You can crop larger dwg/dxf drawings to get rid of unnecessary drawing information. In order to 

use the Crop command, proceed as follows after you have imported the drawing: 

1. Turn off the layers that you do not require. 

2. Choose Explode block to split the drawing into smaller entities according to B.  

3. Select the entities that you want to keep in the drawing area using the Select Rectangle.  

4. Place the mouse pointer on a yellow snap point in the selected group, right-click and select 
Crop. All selected entities will now remain in the drawing area, whereas the remaining ones 
are deleted. 

5. Select any possible remainders that were not included in the cropping and delete these 
manually using the Delete key. 

 

--------------------------------------------------------------------------------------------------------------------------  
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D. All entities in a dwg/dxf drawing can be converted into Configura information. It is however not 
recommended to convert a whole drawing; simply select the entities that you wish to convert. In 
order to convert drawing information, proceed as follows after you have imported the drawing: 

1. Turn off the layers that you do not require. 

2. Explode the drawing according to B.  

3. Crop the drawing according to C.  

4. Select the entities that you want to convert using the Select Rectangle.  

5. Place the mouse pointer on a yellow snap point in the selected group, right-click and select 
Convert to Line Drawing. 

 

--------------------------------------------------------------------------------------------------------------------------  

 

Tips 

When working with imported dwg/dxf files, keep the following in mind: 

 Always turn off the layers that you do not require. 

 Working with the drawing (such as zooming in/out in the drawing area) will be much faster if you 
explode the drawing. 

 Crop larger dwg/dxf drawings to get rid of unnecessary drawing information. 

 Only convert entities that you require. 
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7 Drawing Building Architecture Characteristics 

The program's drawing module is divided into two tabs - Line Drawing 1 and 
Line Drawing 2. Here you can create anything from a simple office layout to 
large warehouses using the measurements you took at the customer‟s facility. 
Provided that you set a height to the various components (lines, arcs, circles 
etc.), you will also be able to view your layout in 3D. On the line drawings you 
can also add dimensions and calculate surface areas. 
 

7.1 Saving and Naming from the Start 

A basic principle is to name the drawing and decide where to save it from the 
start. This is done in the usual way by going to File and selecting Save as. 
 

7.2 Pre-setting the Defaults 

Before you start making a drawing layout, it is a good idea to 
pre-set the values that are known. You do this in the Defaults 
dialog, accessed by clicking on the Defaults button at the top 
of both line drawing tabs. These settings will only apply to 
components which have not yet been positioned in the drawing 
area. The dialog has three main tabs: General, Surface and 
Dimension. At the bottom of the dialog is a Reset to Default 
Values button where at any stage, you can reset the dialog to 
the default values. 
 
The dialog box contains three tabs: 
 

 General: Here you pre-set values for the lines, arcs, 
circles, ellipses and rectangles found on the Line Drawing 
1 tab.  

 Surface: On the Surface tab, you pre-set values for the 
Surface component on the Line Drawing 1 tab. A surface 
can be added to decorate the drawing or simply to 
calculate the square meters of a room. It is also possible 
to add a thickness to the surface and the distance from the 
surface to the floor and use it as a floor, ceiling etc. in 3D. 
Here, you can also pre-select the color that you want the 
surface to have in the drawing area. 

 Dimension: On the Dimension tab, you pre-set the 
properties for the dimensions that you find under the Line 
Drawing 2 tab.  

 

7.3 Finding Active Information in each Drawing Component 

Line drawing components snap to one another. When you move a new line drawing component 
towards another, which is already positioned in the drawing area, the new component automatically 
finds specific points on the positioned component:  

 Configura automatically finds the end and the middle of straight lines and the end and the center 
of arcs and circles.  

 When you stretch a line, Configura finds the perpendicular connection to both lines and arcs. 

 On arcs, Configura also finds the point where a line touches the arc. 

 

When Configura finds these points, a help text is displayed. 

Drawing made in Configura 
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7.4 Placing a Line Component in the drawing area 

A line component is picked and placed in the same way as other components in Configura. However, 
line components are never positioned after just one click, which is indicated by a blue input display. 
Here you enter the desired component parameters, such as length, depth and angle. Every entered 
value is confirmed by pressing Enter. 
 

 
 

Note: 
If you move the mouse pointer outside the drawing area before you have specified all the required 
values for a specific component, the component will still stay in the drawing area and adjust to the 
values typed in so far. If, for any reason, you would like to avoid this behavior, press the Esc key 
(whilst the component is still on your mouse pointer). 

 

This is how the blue input displays work: 

1. You enter the values you want by using the keyboard. When you enter a value, it is highlighted in 
bold and the component is "locked" on the basis of the specified settings. 

2. You open a locked value using the Space bar key.  

3. You lock a value using the Space bar key. 

4. You can delete a locked value using the Backspace key.  

5. You move between the text fields using the Tab key. 

6. If a question is asked in an input display, you only need to enter the first letter of the answer: Y for 
yes, N for no, L for left and R for right. 

 

You confirm dimensions and choices you have entered in input displays by: 

 Clicking with the mouse button. 

 Pressing Enter. 

 Pressing an arrow key (replaces the two alternative commands above and confirms the fed-in 
value at the same time as it specifies the direction). 

 

7.5 Changing Components after Placement in the drawing area 

In order to change a component that has already been positioned in the drawing area, right-click on it 
and chooses Settings. Make the desired changes in the Settings dialog box that appears. You can 
also stretch and shrink line drawing components after you have positioned them, just as you can most 
other components in Configura. In this case, however, you cannot enter an exact value.  
 
To change the length of line and enter an exact value without having to right-click and open its 
Settings dialog, follow these instructions: 

1. Double-click on one of the line's snap points and move the pointer slightly.  

2. Enter a new value in the input display that appears automatically. 

3. Confirm the length by clicking the mouse button. 
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7.6 Using the Drawing Aids 

The top row of components on the Line Drawing 1 tab is called Drawing Aids and consists of five 
components. Drawing Aids are, as their name suggests, tools to help you when you are creating a 
drawing. The drawing aids do not appear on printouts. 
 

 
 
The five components are used for different purposes. They are described below from left to right: 

 The Reference point is an artificial snap point. You fix other line drawing components to it. 

 The Multiple reference points component is used to create a number of reference points one 
after another.  

 The Help line is used, for example, to create intersections or a network of coordinates in the 
drawing area.  

 The Multiple help lines component is used to draw several help lines one after another. 

 The Reference point on arc is used in the same way as the standard reference point, but on 
arcs. 

 

7.7 Using the Drawing Tools 

Using the three tools Trim line, Join lines and Double line or arc, you can delete parts of lines, fill 
gaps and create double lines. 
 

 
 

7.7.1 Trimming a Line 

Using Trim line, you can delete a specific part of one line or of several lines at the same time.  
It can be used in two different ways: 

 “Erase” one line at a time. 

 Allow the red line to cross one or several lines that you wish to remove. 
 

  

1 2 

 
  

 

Note: The Trim line tool trims a line up to where it meets another line. For example, if you trim one 
side of a square or rectangle, the whole of that side will disappear. 
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7.7.2 Joining Lines  

Using the Join lines tool, you can join lines in corners.  
 

 
The gap between the lines is filled automatically 

 

7.7.3 Doubling Single Lines 

It is easy to make double versions of single components, using the Double line or arc tool. It is also 
possible to choose on which side you wish to place the double line.  
 

7.7.4 Mirror Components 

By using the Mirror components tool, you can mirror items at the other side of a line, e.g. a window 
placed on a wall.   

 
 

7.7.5 Mirror and Copy Components  

By using the Mirror and copy components tool, you can mirror and duplicate items at the other side 
of a line, e.g. if you wish to mirror and copy two windows that you have placed on a wall.  
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7.8 Coloring the Drawing / Calculating the Square Meters 

On the Line Drawing 1 tab you will find the Surface component. It is possible to apply a surface 
within a closed area on the drawing, to make quick surface calculations (calculate the square meters) 
or simply to add some color to the drawing. Add desired color to a surface by right clicking the surface 
and select Material/Color.  
 

 
Drawing with surfaces in different colors. 

 

7.9 Placing a Window 

The windows are found at the top of the House 
Components tab. Before you start drawing, it is possible to 
pre-set values for the windows. Click on the Defaults 
button in the upper part of the menu.  

 
To place a window, proceed as follows: It is important that the depth of the window is the 

same as the thickness of the wall!  

1. Place a reference point on the inner wall. 

2. Select a window from the component tab and move the mouse pointer towards the reference 
point until the window snaps to the point.  

3. Click to place the window in the drawing area.  

4. Enter the desired window length in the input display and click. 

5. Move the pointer across the wall (point at the outer wall). The window depth is now automatically 
adjusted to the wall thickness. 

6. Confirm by clicking. 

 

By right-clicking on the window you can change the type of window and its 
features in the usual way. Change the orientation of the window under Settings 
and select Window (that is if the pane should be placed along the inner or the 
outer wall) or add a horizontal division under Details, to create a transom 
window. 

 
 Transom window  
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7.10 Placing a Door 

The doors are found in the same tab as the windows. Before 
you start drawing, it is possible to pre-set values for the doors. 
Click on the Defaults button on the upper part of the tab  
 
To place a door, proceed as follows: 

1. Place a reference point on the inner wall. 

2. Select a door from the tab move the mouse pointer 
towards the reference point until the door snaps to the 
point.  

3. Click to place the door in the drawing area.  

4. Enter the desired door length in the input display and click.  

5. Move the pointer across the wall (point at the outer wall). 
The door depth now automatically adapts to the wall 
thickness. 

 
It is important that the depth of the door is the 
same as the thickness of the wall! 

6. Confirm by clicking.    

7. Move the mouse pointer in the desired direction to select door side and door angle and click. 

 
By right-clicking on the door and select Settings you can change type of door and its features in the 
usual way. 

 

7.11 Exploding a Double Line 

Line–drawing components built up as entities, such as rectangles or a double lines, can be exploded. 
This means that the entity is split up in separate lines. Right-clicking on the component and choosing 
Explode accesses this function. 
 

7.12 Locking the Line Drawing 

When you have finished working with the building on the drawing layout and you want to start working 
with the interior and placing your products, go to View in the menu and activate the function Lock 
Line Drawing. All the components on the Line Drawing and House Components tabs are now 
deactivated on the component tabs and locked in one layer in the drawing area.  
 

Tips 

 Preparatory information is important: What dimensions do I need? What other information is 
important to have before I start drawing? 

 Plan your drawing work: Are the default values the correct settings for what I am about to draw? 
Do I need to use the drawing-aid components? 
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Exercise 4 – Adding Text  

You can create text blocks, type in text and place them anywhere in the drawing area. The text block 
can either be attached to another component or be placed freely in the drawing area. 
 
To attach text to a component, proceed as follows: 

1. Select Text from the Tools tab.  

2. In the drawing area, move the mouse pointer close to the component you want to snap the text to. 
The text snaps to other components. Before clicking the text into position, determine its angle by 
moving the mouse pointer in the desired direction. Click the text into position. Two snap points 
appear - one is triangular and the other rectangular.  

3. The Text Settings dialog is displayed. In the Font field, select the desired font, whether it should 
be in Bold or Italic, enter its Size and select Font color.  

4. Move down to the white text box and enter the desired information. 

5. In the Properties field, check or uncheck the Frame box, depending on your preferences. Select 
the desired Line style from the drop-down list. 

6. Click on OK or Apply.  

7. If you want the text to be at a short distance away from the component it is snapped to, click on 
the rectangular snap point and drag the text the required distance away. Release the mouse 
button when you have finished moving the text. A dashed line appears between the text and the 
component. 

8. If you want to remove the text, disconnect it first by clicking on the triangle shaped snap point and 
then delete it in the usual way. 

 

 
 
The picture shows an example of the text placed freely as a heading (1), as well as pointing directly to an object (2). 
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To place the text freely, proceed as follows: 

1. Go to the Tools tab. Select the Text component and move it to the drawing area.  

2. Press the Shift key on the keyboard to avoid the automatic snapping to other components and 
place the component in the desired position.  

3. Move the pointer outside the drawing area to release the new text component that automatically 
appears. 

4. The Text Settings dialog is displayed. In the Font field, select the desired font, whether it should 
be in Bold or Italic, enter its Size and select Font color.  

5. Move down to the white text box and enter the desired information. 

6. In the Properties field, check or uncheck the Frame box, depending on your preferences. Select 
the desired Line style from the drop-down list. 

7. Click on OK or Apply.  

 
Note: All lists (quotation, bill of material etc.) that Configura generates automatically, are created in 
real time from the contents of the Configura drawing. Therefore one cannot add text directly to such a 
list. For example, addition of extra descriptive text for certain articles will be done as described above, 
thus applying the text as a property to the objects in the Configura drawing. 
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Exercise 5 – Dimensioning  

You can display different types of dimensions on the drawing layout. You find the dimensions on the 
tab Line Drawing 2.  
 
In order to display a dimension along a line, proceed as follows: 

1. From the Line Drawing 2 tab, select either the Horizontal dimension or the Vertical dimension. 

2. Position the dimension at the end of the line you want to dimension. The dimension will snap to 
the line. When you click, an input display appears. 

3. Drag the dimension to the other end of the line and click it in position. 

4. In the Distance field in the input display, you enter the distance between the dimension line and 
the line you are dimensioning. The default value is 500 mm. 

5. In the Gap field in the input display, you enter the size of the gap between the adjacent dimension 
lines and the line you are dimensioning. You move to the Gap field using the Tab key.  

6. Choose which side of the line where the dimension should be by dragging it with the mouse and 
click it into place.  

7. Choose the position of the dimension text by moving the mouse pointer along the line of the 
dimension, thus allowing Configura to automatically find three possible positions for the text. 

8. Finally click the dimension into position.  

 
Note:  

 On the tab, below the dimensions, a number of various arrow types are found.  

 Right-clicking on a dimension in the drawing area and choosing Settings, enables you to change 
its settings (text size, arrow type, distance, gap etc.) in the usual way. 

 According to the description above you determine 
where to place the text by allowing Configura to find 
three possible positions, before finally placing the 
dimension in the drawing area. However, it is important 
to remember that when placing a dimension on a small 
component, the text should be positioned outside the 
actual dimension and not in the middle of it. If the text is 
fitted within the dimension, it becomes very small that it 
will be hard to read. In order to change the text position 
afterwards, click on the yellow snap point located right 
beneath the text, press the mouse button and drag the 
snap point to the left or to the right (up or down). The 
text will move outside the help lines and be enlarged. 
Release the mouse button. 

 

          Before                    After 
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Exercise 6 – Making Drawing Layouts from Handmade Sketches 

Components to be used: 
 
Sketch I - Double rectangle 
  - Reference points 
  - Door 
  - Window 
  - Square 

 
 
 

Sketch II - Double line 
  - Double arc through three points 
  - Join lines 
  - Trim line 
  - Reference points 
  - Help lines 
  - Curved window 
  - Multiple reference points  
  - Double rectangle 

 
 
 

Sketch III - Outer walls with planning for inner walls 
  - Multiple reference points (Note: Add 100 mm!)  
  - Multiple lines 

- Double line or arc 
- Reference point on arc (chord length) 
- Inner walls 

  - Windows and doors 
  - Floor surface 

- Top surface on inner and outer walls 
  - Dimensions 

 
 
 
 

   
 

The handmade sketches turned into drawing layouts in Configura 
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Exercise 7- Designing a Desktop Using Lines and a Surface 

Proceed as follows: 

1. Design the shape of the desktop by using lines and arcs from the Line Drawing 1 tab. 

2. Apply a surface (found on Line Drawing 2) within this line frame.  

3. Right-click on the surface and choose Settings. Enter the height (thickness) of the surface and 
the distance to the floor.  

4. Right-click on the surface again and choose Material/Color. Choose Predefined/Beech as the 
material of the desktop. 

5. Click on the surface and drag it outside the line frame. Delete the lines. 

6. Experiment with the surface by changing its height and distance to floor. 

7. Continue drawing the legs of the desk using the same principal. Use your imagination! 

 
The line frame is only used to get the shape of the desk and can be deleted after the surface has been placed. 

 

 

 
Result in 3D 
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8 Reviewing and Adjusting Pricing 

This section shows you how to review and modify the automatic pricing. 

8.1 The Calculation Module  

As products are added to the drawing area, the pricing and list of material are automatically 
generated. A total price is always shown in the down left corner of the program window.  
 
To view the complete pricing calculation at any time, go to the Company menu and select 
Calculation. The Calculation dialog opens. All the customized versions of Configura have their own 
calculation dialog, which is tailored to the specific needs of each customer. 
 

 
 
The Calculation dialog for Configura Core contains such information as article numbers and prices and can be used with the 
generic components in the program. When you enter figures or text into an editable text field of a column, you have to confirm 
the entered information by clicking Enter or Tab. By pressing Enter the cursor will jump to the next editable field in the row 
below. By pressing the Tab key, the cursor will jump to the next editable text field in the same row, which you are currently 
working in. 
 

 

With the assistance of the calculation dialog you can price components, work with discounts and add 
sales tax. In most Configura customizations the Company menu also contains an option for entering 
quotation data. 
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9 Producing Output 

Section 9 provides information about how to produce output in Configura. Configura significantly 
improves the quality of the sales documents that you hand over to your customer. The output is, apart 
from drawing layouts, material specifications, quotes and 3D renderings. You can either print the 
output or create a PDF file to send to the customer. 
  

 

 

 
 
Drawing in 2D 

   
  
  

 
    

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3D rendering produced in Configura 
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Exercise 8 – Printing the Drawing Layout  

 

The easiest way to print a drawing is simply to select the desired paper size (for example Letter or A1) 
for printing and then use the Fit button, which automatically chooses the optimal scale for printing all 
the components in the drawing area on the chosen paper size. 

 

Note:  

As this method fits all the components in the drawing area to the selected paper size, you might end 
up with unusual scales, for example 1:47 or 1:89. 
 
Proceed as follows: 

1. Go to the File menu and select Print. In the dialog, which is displayed, check the Drawing box in 
the Print Drawing field. The only selectable choice now shown is the Drawing Area. However, 
leave the checkboxes in the Print List field unchecked. At this point you only want to print out the 
drawing.  

2. Next to the heading Scale, select the Fit button. 

Note:  
The Fit button exists as an option in Configura Core. However, the layout of the print dialog box and 
its level of complexity vary in the different customized applications of the program. 

1. Enter the number of Copies you want to print.  

1. Click on the Printer button, in order to select printer, paper size and orientation (portrait or 
landscape). Confirm with OK. 

2. In the white field next to the heading Drawn by, type in a signature. This information will end up at 
the bottom of your drawing, together with the current date. 

3. Click the Preview button to see what the drawing will look like before you print it. 

4. In the Print Preview window, finally print the drawing by selecting the Print command in the 
menu with the same name. You can also click on the Print button furthest to the left in the toolbar.  

 

Select the Fit button in order to fit all the components in the drawing area to the selected paper size. 
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Exercise 9 - Using a Print Frame 

The Print Frame makes it easier to position the drawing on the paper. You place the frame, your 
"paper", around the area to be printed and thereafter specify the desired paper size, orientation and 
drawing scale. This way, you can work with the drawing layout and view the result right away on the 
screen.  

 

The print frame also enables to print a selected part of a larger drawing and is also recommended 
when you want to print at a certain scale. 

 

Proceed as follows: 

1. Select the Print Frame component from the Tools tab. 

2. Move the mouse pointer onto the drawing area. A blue frame is attached to it. 

3. Position and stretch the print frame in one step. Press and hold the left mouse button whilst 
dragging the mouse pointer diagonally across the drawing until desired frame size. Make sure 
that the items you want on your printout are inside the frame.  

4. Release the mouse button. Leave the drawing area to drop the component. The Print Frame 
Settings dialog is shown. 

5. Click on the Printer button. In the dialog box that appears, select the desired printer, paper size 
and orientation. Click on OK to confirm and to close the dialog. 

6. Back in the Print Frame Settings dialog, select Apply in order to see how the frame adjusts to 
your settings and too see the drawing header. 

 

  

7. Depending on the result in the drawing area, select a suitable printing Scale, by clicking on one of 
the buttons. Confirm with Apply. 

8. In order to center the objects in the print frame, proceed to the drawing area. In the upper right-
hand corner of the frame you will see a yellow little box. Click on the box once. The objects in 
your drawing are now centered in the printable area of the frame. 

9. Click on the Print Settings button to open the dialog box Standard – Print Settings. 

10. In the dialog, check the Drawing box in the Print Drawing field.  
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11. Make sure that the print frame is selected (i.e. that its yellow snap points are visible), the pre-set 
choice is now Selected print frame. If you have several print frames and want to print them all, 
check the button All print frames. 

12. If you want a logotype to appear on the printout, check the Show logotype box and browse for 
the bitmap file. 

13. Enter the number of copies you want to print. 

14. If you want to see in advance what the printout will look like, click on Preview.  

15. If you are happy with the result, click on Print to the far left in the toolbar. 

 

Note: 

 If, by accident, you have closed down the Print Frame Settings dialog, simply double-click 
between the broken blue line and the black line of the print frame to make it appear again. 

 You select a print frame by clicking on the very edge of the frame, between the blue dotted line 
and the black solid one.  

 There is a blue inner frame inside the black solid one. You can clearly see where the drawing 
header is. Make sure that the whole drawing is inside the blue frame - items placed outside will 
not appear on the printout. 

 To be able to select the alternative Selected print frame in the print dialog, the frame must be 
selected.  

 After you have placed and selected the frame in the drawing area and done your printer setup in 
the Print Frame Settings dialog, it is also possible to close the dialog and print out the drawing in 
the usual way by going to the File menu and select Print or by clicking on the icon in the toolbar. 

 To move the print frame in the drawing area, click between the dashed blue line and the black 
line, and drag the frame. 

 You can also set the drawing scale by stretching the print frame. Click on one of the three snap 
points on the right-hand side of the frame, hold down the mouse button and drag the frame until it 
is the size you want. 

 When you print several print frames, you can print each one at a different scale and on a separate 
printer. 
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Exercise 10 – Printing the Quote  

When the drawing is finished, the price calculations, quotations, bills of production and even technical 
calculations are automatically produced, thanks to the built-in information in all of the program‟s 
different components. 

   

   
When the drawing (1) is finished, the calculations (2) and the quote (3) are automatically produced. 

 

The calculation dialog can be opened either before or after the components have been placed in the 
drawing area. The calculation dialog will automatically list everything in the drawing area.  

  

In order to use the calculation, proceed as follows: 

1. If you prefer to have the Calculation dialog open from the start in order to watch it being updated 
as you add objects to the drawing area, go to the File menu and select Control Panel. On the 
General tab, turn on Configura‟s price calculation by checking the Calculate price box. Click OK. 
By activating the price calculation, the program will also automatically display the total price of all 
the components in the drawing area in the lower left-hand corner of the program window. 

2. In the Company menu, choose Calculation. A dialog is displayed.  

3. Place the components that you would like to have in the drawing area. Information about these 
components is added automatically to the Calculation dialog.  

 

--------------------------------------------------------------------------------------------------------------------------  

When you have previewed the listed products and the pricing, made the desired changes in the 
green, editable fields and confirmed these with Enter or Tab, it is time to print out the quote. 

 
To print out the quote, proceed as follows: 

1. In the Company menu, open Quotation information (or corresponding). Fill in the necessary 
information, such as the client name, office address and other details and confirm with OK. 

2. Go to the File menu and select Print.   

3. I the dialog box now displayed go to the right-hand field (Print List) and check the items that you 
would like to print out (Material list, Quotation etc.).  

4. In order to insert a logotype (in the bitmap format) on the quotation, check the Show logotype 
box and then click on Browse in order to find the file that you would like to insert. 

5. Enter the number of Copies you want to print.  

6. Click on the Printer button, in order to select printer, paper size and orientation (portrait or 
landscape). Confirm with OK. 

7. Click the Preview button to see what the drawing will look like before you print it. 

8. In the Print Preview window, finally print the drawing by selecting the Print command in the 
menu with the same name. You can also click on the Print button furthest to the left in the toolbar.  
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Exercise 11 – Creating a PDF File  

To save reports and drawings in PDF format and send as an e-mail attachment straight from 
Configura, follow the steps below.  

 

Note that the PDF functionality is included in Configura Core but has to be implemented in the 
customized applications. 

 

Proceed as follows: 

1. In the Standard – Print Settings dialog, click on the button Save as PDF.  

2. Name the drawing and choose where to save it. 

3. Click on Save. 

4. The files (drawing and lists) are now opened up in Adobe Acrobat Reader, provided that you 
have this program installed on your computer.  

 

 
Drawing with enclosed material lists saved as a PDF file in Configura and then opened in Acrobat Reader. 
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Exercise 12 – Exporting to Cad    

You can export Configura drawings to the Cad file formats dwg and dxf. The option Export Drawing 
to Cad (dwg/dxf) on the Import and Export tab enables export of the drawings you have created in 
the program. 
 
To export to dwg/dxf, proceed as follows: 

1. On the Import and Export tab, select the button Export Drawing to Cad (dwg/dxf). The dialog 
Cad Export Settings (dwg/dxf) is displayed.  

2. In the File field, click on Browse to select a file destination, name the file and click on Save.  

3. From the Version drop-down list, choose the AutoCAD version that you want to export to.   

4. In the Properties field, choose the Scale using one of the pre-defined buttons or click on the 
rightmost button and enter the desired scale in the box. In the same field, also select the desired 
Model Space Unit. 

5. In the Area field, choose whether you want to export the Whole drawing or a Selected group 
(objects that you have selected in the drawing area).  

6. The Export field enables you to determine what kind of information you want to export. Selecting 
Configura objects will enable you to export not only the 2D information but also the 3D information 
in the drawing. You can also choose to export all (dwg/dxf) information in the Configura drawing 
by checking the Cad Objects (dwg/dxf) box. 

1. Click on OK when you have finished your selections. 
 

 
The Cad Export Settings (dwg/dxf) dialog box. 
 

 

Note: In order to export a Configura drawing to one of the Cad formats dwg/dxf, the drawing has to 

have a Cad zero point (a starting point that determines the drawing's position in the drawing area). 

Configura automatically inserts a zero point in the drawing area, if it is missing when the drawing is 

about to be exported. 
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10 Rendering 

The automatic rendering options in Configura‟s toolbar, Auto 3D (Fast) and Auto 3D (Detailed), are 
perfect for quick visualizations of the environment that you have created in the drawing area. 
 

 
Configura’s two camera options used to create automatic 3D renderings in Configura 

 

It is also possible to manually create different types of 3D renderings; anything from simple black-and-
white perspectives to photo-realistic full-color renderings where the camera angle and the lighting can 
be set. Just like real photography, it is then possible to make more advanced settings, such as 
determining the target point and the distance from the camera to the target, the camera height and 
the camera angle. This way you can make full use of the Configura system, creating the design 
together with the client and quickly being able to visualize their new space.  

 
The Camera tool enables manual image rendering and is available on the Tools tab. 

 

 
The Camera component used to manually create 3D renderings in Configura. 

 
Below we will give an overview of the Camera tool, the Camera View where you preview your 
products and finally the different sections in the Camera Settings dialog.  

10.1 The Camera Tool 

The camera is found on the Tools tab. It is possible to position the camera and set its distance and 
angle in one step. When placing the camera in the drawing area (at some distance from the object 
that you are taking the picture of), continue to press and hold the mouse button and then drag until 
the desired distance and wide-angle. The Camera View dialog appears automatically. Click Escape 
to drop the new camera, which appears automatically. Double-click on the camera in the drawing area 
to open the Camera Settings dialog. 
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10.2 The Camera View  

When a camera is placed in the drawing area, Configura‟s Camera View automatically appears. If the 
OpenGL (Open Graphic Library) feature is activated in the Settings menu, a full-color view is shown. 
If not, you will only see a black-and-white wireframe mode. 
 

 
The Camera view when the OpenGL feature is activated. Textures and other details are displayed if the quality is set to High in 
the OpenGL menu (see 8.2.2) at the top of the camera view. 

 
The Camera View enables you to navigate in real-time 3D while creating your design. Any changes 
you make in the floor plan (size, material etc.) are reflected in the 3D view. This is a great help when 
adjusting camera height and angle or when zooming in on a specific detail. 
 
 

10.2.1 The Settings Menu 

The Settings menu has four options, which are usually activated by default: 

 OpenGL: Turn on/off the OpenGL feature in the Camera View. 

 Software: The Software option controls the rendering in the camera view to some extent. By 
default, the OpenGL color view is rendered using software that is built into the program, as 
opposed to using hardware (i.e. the graphics card). Software rendering requires more processor 
power. If you find that the rendering in the camera view slows you down when you are designing, 
uncheck the Software option. Hardware rendering speeds up the animation and OpenGL 
rendering in the preview window. However, in order for the new setting to be activated, Configura 
has to be restarted. 

 Animate. By default, the Animate function is checked when the Open GL feature is activated. 
Animate updates changes in the camera view right away, i.e. gives immediate response when 
you move the camera or the camera target. Turning off the animation will only update changes in 
the camera view after you have released the camera. 

 Preserve Aspect Ratio: The Preserve Aspect Ratio option is checked by default. It will secure 
that the camera view always maintains the correct proportions when stretching the actual window 
to a different size. The camera view should always show the same result as a rendered image. 
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10.2.2 The OpenGL Menu 

The OpenGL menu contains three quality options: 

 High: For maximum image quality in the camera view. This option makes the rendering time of 
the image in the camera view slower. 

 Medium: Slightly poorer quality of textures for example. However, a faster option to work with. 

 Low: The lowest quality but, on the other hand, large drawings can be worked on more quickly. 

 

10.2.3 The Slider Bar 

The slider bar to the right of the Camera View is used to limit the number of objects, which are shown 
in the view and used as well for quicker navigation. The fewer objects, which are shown, the faster it 
will be to update changes in the camera view. The right-hand field at the bottom of the dialog displays 
the maximum number of objects that can be shown (Max) and the actual number of objects that are 
shown in the drawing (Drawing). 
 

10.2.4 Re-render with Current Objects 

The topmost button is used to update the camera view, for example, when another window has 
hidden the camera view and the rendered image has disappeared temporarily. 
 

10.2.5 Zoom In/Out 

The two zoom buttons enable you to quickly zoom in on, or zoom out of, objects in the camera view. 
 

10.2.6 Camera Settings 

The fourth button from the top takes you directly to the Camera Settings dialog box (see 8.3). Note 
that nothing will happen if this dialog box is already open. 
 

10.2.7 Develop 

By clicking on one of the Auto 3D buttons a rendered image will instantly be created in a separate 
window. The same thing will also happen when you choose Develop in the Camera Settings dialog 
box. 
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10.3 The Camera Settings Dialog  

The Camera Settings dialog box contains six main sections divided up on different tabs: Camera, 
Environment, Lighting, Image, Sketch and QTVR. 

 
The Camera Settings dialog box with its six sub-divisions. 

 

10.3.1 The Camera tab 

With the Camera tab you can adjust the Camera height and the Target height by suing the two-
slider bars. Adjusting these settings will change the camera‟s inclination angle.  
 
Clicking the Range button will open a dialog where the maximum/minimum height limits can be 
changed for the camera and the target. Should you wish to apply some special effects to the rendered 
image, such as transparency or post-processing, click on Advanced. 
 
It can be difficult to position the camera and to produce a good view in a smaller environment. The 
Image Content field offers two possibilities to get around this dilemma. Using one of the options 
Limited area or Volume clipping, you can clip a 3D rendering and restrict the rendering output in the 
3D view. The Limited area feature will add a rectangular stretchable area to the camera angle (only 
shown when the camera tool is selected). Stretch out the rectangular area to the desired width and 
depth. Only the information inside this area will appear in the 3D rendering. The Limited area feature 
will also allow the camera to only focus on a part of a larger drawing and thereby reduce the time it 
takes to render the image. 

 
Note: If you wish to use the Limited area option to be able to look into a rectangular room, the 
rectangle must first be divided into four separate walls. You do this by right-clicking on the rectangle 
and selecting Explode. 

10.3.2 The Environment tab 

On the Environment tab you can make different types of changes to your 3D environment. Checking 
the boxes Ceiling and Floor will automatically add those items to your 3D rendering and the changes 
will be reflected in the Camera View. Enter the desired ceiling height, apply a color or a texture to the 
floor or the ceiling and change to a different background. Clicking the Advanced button enables you 
to apply different special effects to the rendered image. 
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10.3.3 The Lighting tab 

The Lighting tab will help you achieve different lighting effects in your 3D renderings. For example, it 
is possible to set the color and the strength of the ambient lighting. The Help Lighting box is checked 
by default and will insert light sources temporarily when a photo is being rendered. The program will 
then automatically manage the lighting of the 3D rendering that you manually render using the 
Camera tool.  

 
Note:  

 The settings made on this tab will only affect image rendering done with the Camera tool. 

 The default setting for ambient lighting is 600 lux. However, lighting up a large environment 
demands more light than one with only a few objects in it. It always a good idea to experiment a 
little and change the ambient lighting from case to case. Although you can set the ambient lighting 
to as much as 2000 lux, you should normally not exceed 1100 lux. If the light is too strong, this 
will affect the image quality negatively. 

 Just changing the ambient lighting will not result in an ultimate result. A combination of different 
lighting tools (for example a spotlight, a sun or one of the lighting fittings that are available under 
Lighting on the Accessories tab) will give you a more realistic setting. 

 A tip is to give the ambient lighting a warmer color by adding a more yellow tone to it. Under 
Color, click the Browse button and apply the desired color tone. 

 

10.3.4 The Image tab 

The Image tab enables you to set the desired size, format and resolution of the rendered image. 
Changing to a different Window Size in the Preview field will only change the size of the window in 
which the image is rendered. Clicking the Show image button will display the latest rendered image. 
 

10.3.5 The QTVR tab 

QuickTime VR is a method developed by Apple Computer that allows you to produce a 360-degree 
graphic of the client‟s proposed space that you have created in Configura. This will generate a small 
QuickTime file that can be e-mailed easily. To open the file, QuickTime Player (free of charge) is 
required. 
 
There are three different kinds of 360-degree graphics, or “movies”, that can be generated in 
Configura:  

 Panoramic: Panoramic movies are used when you have created a complete environment (a 
building with surrounding walls). The graphic is then taken from a central position, as if you were 
standing in the middle of the room, rotating on the spot while holding the camera. 

 Object: Object movies are suitable for visualizing freestanding objects. The graphic is created 
with the camera circulating around the objects whilst creating different shots. 

 Simple Object: Simple object movies are suitable for visualizing free-standing objects. The 
graphic is created with the camera circulating around the objects whilst creating different shots. 
This generates smaller files than the option above. 

 
Panoramic movies are best suited to visualize environments 
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10.3.6 Develop 

You can click on the Develop button in the top-right corner of the Camera Settings dialog at any 
time. Before doing so, select one of the following rendering options:  

 Perspective (creates a black-and-white perspective) 

 Fast light test (creates a low-resolution image without shadow information or textures) 

 Light test with shadows (creates a low-resolution image but still displays shadow information 
and textures) 

 Fast photo (creates a low-resolution image without shadow information or textures) 

 Photo (creates a high-resolution image with shadow information and textures displayed) 

 Superphoto (creates a very high-resolution image with shadow information and textures 
displayed) 

 
Note:  
You normally have to render quite a few test images before you are satisfied with the result. During 
this phase, it is a good idea to select Light test with shadows, an option with fast rendering time that 
still produces a realistic result. For the final result, always choose Photo. Superphoto is only 
recommended for images that should go to print. 

10.3.7 Reset to Default Values 

The button Reset to Default Values in the bottom left corner of the Camera Settings dialog is 
always visible, irrespective of which tab you have selected. The reset function is useful when you 
have tried different settings in the dialog and when you no longer know which ones that are activated. 
Clicking this button will reset all of the settings you have made. 
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10.4 Tips for Better 3D Renderings in Configura 

Here are some guidelines that you can use to get to a more realistic rendering and lighting result in 
Configura. 

 
Camera 

 Place the camera further away from the target and focus by reducing the wide angle, instead of 
trying to move in too close with the camera. This produces a better image with straighter lines. 

 The camera height should not differ too much from the target height. Adjust to a realistic height. 

 

Lighting 

 Remember that a room needs both lights and shadows. Combine different kinds of lighting. In the 
same room, use electric fittings that make the light come from a certain direction light as well as 
fittings that spread the light. 

 Avoid cross-shadows, which is light coming from different directions. 

 Recreate a true sunlight – it will give a sense of realism to your image. Try to think about where 
the daylight would enter in a real setting!  

 Remember that it is always better to prepare for the rendering first (place a camera with a good 
distance to target and a good angle, lighting etc.), before you start decorating the room. Since you 
will have to render quite a few test images before you are happy with the result, it is an advantage 
to keep the image as „clean‟ as possible. An environment with less information will naturally speed 
up the rendering time of the image. 
 

  
Examples of more advanced photography in Configura Core 
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Exercise 13 – Producing a 3D Rendering Automatically  

The fastest way to create 3D visualizations is to click on one of the two cameras in the toolbar, Auto 
3D (Fast) or Auto 3D (Detailed). 
 

 
Auto 3D options 

 

Camera and lighting will then be adjusted automatically and the picture will be taken from a set angle. 
The quality of the rendered image varies depending on which alternative you have chosen. Auto 3D 
(Detailed) has a slightly longer rendering time but is of considerably better quality (shadows and 
textures are only seen with this type of rendering). 

 

Note: 
You can determine what angle to take the automatic picture from. Go to the File menu and select 
Control Panel. Under the Auto 3D tab, select the camera position by clicking on the different arrows. 
If you select the cross in the middle, the camera will be positioned right above the components that 
you are about to photograph. The Auto 3D tab also contains settings for distance from target, light 
strength and environment. 

 

 

 
Example of manual photography in Configura

 

 
For more advanced photography, work with the Camera tool manually (available under Tools). 
Double-click on the camera to display the Camera Settings dialog. Here you can make a whole 
series of settings for image resolution and image quality and also state what surroundings you want 
(background, floor, ceiling etc.). 
 



46 

Exercise 14 – Pasting a Rendered Image Next to the Drawing 

After you have rendered an image in 3D, it can be pasted next to the drawing. 
 
Proceed as follows: 

1. Render an image (automatically or manually). 

2. Click on Image in the top left-hand corner and then on Paste. 

3. Name the file and decide where the image should be saved. 

4. Click on Save. 

5. Close the image. A 3D color rendering automatically appears next to your drawing. Click on the 
yellow frame, between the solid and the broken yellow line, that surrounds the rendering and drag 
it to desired position in the drawing area.  

 

 

 

 
 
Drawing layout with a pasted 3D mage 
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Exercise 15 – Rendering a Black-and-White Perspective  

Black-and-white perspectives are easy to create in Configura. To create an environment and generate 
a perspective in black-and-white, proceed as follows: 

1. Draw a rectangular room. Place a window on the left-hand side. Furnish the room with a few 
objects, for example a desk and a chair.  

2. Go to the Tools tab and select the Camera. Place it in the drawing area.  

3. Set the camera‟s focal distance by clicking and dragging the yellow target point (furthest away 
from the camera tool with a circle around it) into the room, to determine your focus.  

4. Then click and drag the snap point at the back of the camera to move the actual camera tool 
outside the room. Release the button when you have reached a good distance to the focal point 
(see Picture 1 below). 

5. When you have placed the camera, the Camera View will be displayed automatically. In the 
button row on the left-hand side of the view, click on the Camera Settings button. 

 
Note: If you have closed dialogs accidentally simply right-click on the camera and select Camera 
View or Settings right away.  

6. In the Camera Settings dialog, select the Camera tab.  

7. Go to the Image Content field and select Volume clipping. Click on each of the gray snap points 
to activate these. Then click and drag one point at a time, until they are positioned like in to 
Picture 1 below. The final rendering will only display the items between the two points, which will 
allow you to ignore the wall that blocks your view.  

8. On the Camera tab, adjust the camera height and the target height.  

9. Do you need to get closer with the camera? Zoom in by dragging one of the snap points that are 
placed along the camera angle and, thereby reduce the camera angle. Use the Camera View to 
make sure that your camera angle is correct. 

10. On the right-hand side of the Camera Settings dialog, select Perspective as rendering option. 
Finally click Develop. The black-and-white perspective is being rendered (see Picture 2). 
 

  

Picture 1 shows the placement of the camera  Picture 2 shows the result in 3D 
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Exercise 16 – Pasting the Perspective in the Drawing Area 

Perspective renderings can then be pasted into the drawing. 
 

Proceed as follows: 

1. Render a Perspective. 

2. Click Image in the top left-hand corner and then on Paste. 

3. Close the image. A black-and–white perspective now appears in the drawing area. Click and drag 
the perspective to desired position.  

4. Click the perspective‟s yellow right-hand snap point and drag to stretch the perspective in size. 
Note: You can only stretch perspectives – not color renderings.   

5. Right-click on the rendering and choose Settings. Here you can add a frame around the 
perspective and/or to view it in full detail on screen. Note: Regardless of the setting you have 
here, the actual printout will always look ok. 

 

 
 
Print preview of a drawing with a perspective displayed next to the floor plan. 
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Exercise 17 – Producing a Color 3D Rendering 

Here are a few general tips that might help you to produce 3D renderings with a more realistic camera 
setting and lighting. 
  
Proceed as follows: 

1. Use the drawing layout from Exercise 16. 

2. Place a spotlight outside the room. Adjust the spotlight‟s target point to direct the light so that it 
shines through the window. You do this by clicking and dragging the yellow snap point which 
adjusts the distance from the spotlight to the target point (surrounded with a dotted circle) and 
placing it inside the room, in front of the window (see Picture 1). 

3. Reduce the spotlight‟s spread angle by clicking and dragging one of the snap points positioned 
along the angle. The spread angle should be about as wide as the window in the wall (see Picture 
1 below). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Picture 1 shows your drawing layout after placing and adjusting all the lighting. 

 

4. Right-click the spotlight and chose Settings. In the dialog box that opens, set the target height to 
approximately 1100 mm. This way you allow the light to shine in through the window, i.e. 
preventing it from being blocked by the wall. Change the spotlight brightness to 150-200 Watt. 

5. Select the Light test with shadows option in the Camera settings dialog to view the light result. 
Click the Develop button.  

6. Place two fluorescent-lamp fittings (from the Accessories component tab) above the workstation 
(see Picture 1). Re-render to view the result. 

7. If more light is necessary, go to the Camera Settings dialog and select the Lighting tab. Under 
Brightness in lux, increase the ambient lighting to 800-1000 Lux.  

8. If required, change the color of the walls.  

9. If necessary, place a supplementary ceiling light in the front of the room. 

10. On the Environment tab, in the Camera Settings dialog, check the Floor box to automatically 
get a floor. Choose Material/Color to add a texture to the floor. 
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11. When you have created your environment and you are satisfied with the lighting, for the final 
rendering, it is recommended that you increase the image resolution. Select the Image tab in the 
Camera Settings dialog and set the resolution to 150-300 dpi.  

12. Render a Photo. The final result is similar to what you see in Picture 2 below. 

 

 
 
Picture 2 shows the result in 3D. 
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Exercise 18 – Saving and Printing the Rendered Image 

When saving a rendered image you have to select what format to save the image in. Configura will 
save the rendered image in one of the following optional formats: 

 JPEG (.jpg) 
 Targa (.tga) 
 DIB (.bmp) 
 Tiff (.tif) 
 LWI (.lwi) 
 PDF (.pdf) 
 
Note: The JPEG format is recommended for most cases, as the image is compressed and creates 
smaller files. For print however, select the tiff format. 

 
To save a rendering, proceed as follows: 

1. Render a Photo. 

2. Click Image in the top left-hand corner of the window and then select Save. 

3. Name the file, choose image format and where the rendering should be saved. 

4. Click Save. 

 

--------------------------------------------------------------------------------------------------------------------------  

 

If you wish to print your 3D rendering right after the rendering, proceed as follows: 

1. Click Image in the top left-hand corner of the window and then select Print. 

2. Enter the printer settings the usual way and then click OK. 

 
Note: The paper size you choose to print out on should not exceed the image-target size that you 
have already chosen in the Camera Settings dialog. 

 
 



52 

Exercise 19 – Importing an External Image into the Drawing Area 

It is possible to import external images into the drawing area in Configura. Add a customer logo or any 
other image next to the floor plan to further enhance the drawing layout. 
 
Proceed as follows: 

1. Select the Import and Export component tab. 

2. Under Import Drawings and Images, select the feature Import drawing/image as background 
and position it in the drawing area. The dialog Drawing/Image Import Settings is displayed.  

 

 

 

3. Click on the Browse button to select the desired file. 

4. At the bottom of the dialog, set the image size in the drawing area by selecting a value next to the 
Scale (%).  

5. Click on OK or Apply.  

6. To re-position the image, click and drag the frame that surrounds the image to the desired 
position in the drawing area. 
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11 Changing Material or Color on Generic Components  

In Configura, your own products already look, act and respond like they do in reality. But in order to 
recreate a realistic environment, maybe even an exact duplicate of the customer‟s premises, you 
need to make use of the possibilities of changing color or material also on other components in 
Configura Core.  

 

 
3D rendering produced in Configura 

 
The color of desks, chairs and flowers as well as the color of walls, floors and other surfaces can be 
varied and adjusted. Choose between Configura‟s predefined colors and materials, create colors 
yourself or use realistic textures (for example tiles, brick and wallpapers). 
 
The Material/Color Change dialog box can be reached in two different ways: 

1. Go to the Edit menu. Choose Material/Color. The menu option is only displayed if you have an 
selected a generic component in the drawing area 

2. Right-click on the component that you want to change. Choose Material/Color.  

11.1 Surface Name 

Under Surface Name (1), 
choose which part of the 
component the color change 
should apply to.  
For example, on an office 
desk in Configura Core you 
can change the desktop, panel 
and legs. 

11.2 Color Model/Type 

The heading Color 
Model/Type (2) displays three 
color options: Predefined, 
Texture and RGB Color.  

11.2.1 Predefined 

Here you will find various 
predefined materials and 
colors, such as birch, 
aluminum and plastic.  

All three options bring up the same Material/Color Change dialog. 
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11.2.2 Texture 

Textures are images of real materials, for example scanned or digital images of wallpaper, tiles and 
lino floor coverings. The textures must be stored on your PC or on your company's network in order 
for you to be able to use them. Adding textures to walls and floors is a simple, effective way of 
improving the quality and feeling of reality in a 3D picture. Textures are only visible in 3D.   

 

   
Parquet flooring Brick wall  Wallpaper 

Examples of textures made from pictures taken with a digital camera 

 

 

 

As part of the course, we hand out a CD – “Configura Textures No. 1” - 
with more than 300 handmade textures (worth a value of $60). We hope 
that you will find these useful! It is also possible to create your own library 
of scanned textures or pictures taken with a digital camera. For additional 
orders of the Configura textures, please send an email to 
training@configura.com. 
 

 

 

11.2.3 RGB Color 

There are ready-made RGB colors to select among in Configura. RGB colors are defined with values 
for Red, Green and Blue. Besides the ones that are included, you can simply expand the list by 
creating your own colors and save them in a color database. 
 

11.3 Apply to 

Under Apply to field (3) you specify which components you would like to be affected by your color or 
material change. This could be just one component, a group of components, components in a defined 
position or all similar components in the drawing area. 

 

When you choose to apply the color or material changes to more than one component, the following 
sub-options are displayed. 

 Equal Components: Changes material or color of all components of the same kind. 

 Equal Surface Names: Changes a specific detail (the one selected under Surface Name) of 
several components in the drawing area, for example all desk legs of the desks in a selected 
group. 

 Equal Material/Color: Changes material or color of all details with the same material or color as 
the selected detail under Surface Name. 

 

mailto:training@configura.com
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11.4 Show/Hide OpenGL preview 

At the bottom of the Material/Color Change dialog, you will find the button Show OpenGL preview 
or Hide OpenGL preview respectively (see nr 1 on picture below). When clicking on it, a new window 
will open on the right side of the dialog, showing the object that is selected in the drawing area. If you 
change the material of, for example, a desk in Configura you will see the change previewed directly in 
3D, provided you have chosen to show the OpenGL preview. To hide the OpenGL preview, press the 
Hide OpenGL preview button. 
 

 
 

Note: 

 To rotate the object in the OpenGL preview window, and thereby be able to view it from different 
angles, use the four arrow buttons placed directly above the window (see nr 2 on picture above). 
You can also rotate the object by placing the mouse pointer on the 3D rendering in the preview 
window and then pressing and holding the left mouse button and dragging the mouse in the 
desired direction.  

 To zoom in and out in the preview window – i.e. enlarge or reduce the object - use the two 
buttons with magnifying glasses located at the top right of the window (see 2 on picture above). 
You can also place the mouse pointer on the 3D rendering, press and hold the right mouse button 
and move the mouse up or down.  
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Exercise 20 – Changing the Color of Walls  

A fast and easy way to get a better 3D rendering result is to change the color of the walls in the 
environment that you have drawn. 

 

Proceed as follows: 

1. Draw two walls that form a corner – see below. 

 

 

 

 

 

 

If you draw an open corner instead of a closed rectangle, it is easier to look into the room when rendering an automatic 3D 
image.  

2. Select both walls so that the yellow snap points are visible, by pressing and holding the Ctrl key 
as you click on one wall at a time.  

3. Place the pointer on a snap point and right-click.  Choose Material/Color.  

4. A dialog box is displayed. Choose RGB Color and thereafter the color you prefer.  

5. In the field Apply to, select Group and Equal Surface Names. Click OK. 

6. To see the result, render an Auto 3D. 
 


